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Preface

This guide is part of the EMC Legato NetWorker documentation
set. For a complete list of documents related to the use of this
product, see "Related Documentation" on page 15.

This guide provides information on how to configure and manage
the NetWorker software.

Install the NetWorker software on the appropriate server and
clients before using the information presented in this guide. Refer
to the NetWorker Installation Guide for the relevant platform for
installation instructions.

For the most up-to-date information NetWorker features, refer to
the Release Notes.

AudienceThe information in this guide is intended for system
administrators who are responsible for setting up and maintaining
backups on a network. Operators who monitor daily backups will also
find this guide useful.

OrganizationTo find information about the user interface and
basic tasks, see:

"Chapter 1: Overview" on page 19

To set up backups and configure devices for backups, see:

"Chapter 2: Backing Up Data" on page 47 "Chapter 3: Configuring
Libraries and Devices" on page 95
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To find detailed information about managing backup data,
see:

"Chapter 4: Backup Groups and Schedules" on page 127 "Chapter 5:
Browse and Retention Policies" on page 163 "Chapter 6: Directives"
on page 179 "Chapter 7: Sorting Backup Data" on page 197 "Chapter
8: Archiving" on page 219

"Chapter 9: Cloning Backups" on page 237 "Chapter 10: Staging
Backups" on page 255

To find detailed information about devices and media, see:

"Chapter 11: Device Operations" on page 291 "Chapter 12: Media
Management" on page 319

To recover data, see:

"Chapter 13: Recovering Data" on page 361

To create reports and monitor NetWorker activity, see:

"Chapter 14: Reporting" on page 407 "Chapter 15: Monitoring" on
page 463

To manage hosts including the Console server, NetWorker server,
and NetWorker clients, see:

"Chapter 16: Console Server Management" on page 483 "Chapter 17:
NetWorker Server Management" on page 507 "Chapter 18: NetWorker
Client Management" on page 559

To manage NetWorker software in a cluster environment.

"Chapter 19: Cluster Support" on page 579

To manage a NetWorker server in a Network Data Management
Protocol (NDMP) or Simple Network Management Protocol (SNMP)
environment, see:

"Chapter 20: NetWorker Server Support for NDMP" on page 615
"Chapter 21: SNMP Module" on page 687

To find detailed information about how NetWorker software works
with various supported platforms and platform features, see:

"Chapter 22: Support for Microsoft Removable Storage" on page
693 "Chapter 23: Support for Microsoft SharePoint Portal Server" on
page 717
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"Chapter 24: Support for Microsoft Automated System Recovery" on
page 727

"Chapter 25: DiskXtender Data Manager File System Support" on
page 741

"Chapter 26: Volume Shadow Copy Service" on page 753 "Appendix
A: SYSTEM and VSS SYSTEM Save Sets" on page 813 "Appendix B:
Firewall Support" on page 823

"Appendix C: Backing Up and Restoring a Microsoft DFS" on page
843 "Appendix D: Additional Features of the Microsoft Windows
Server" on

page 849 "Appendix E: UNIX and Linux Platform-Specific Notes" on
page 865 "Appendix F: Mac OS X Support" on page 881

To find detailed troubleshooting information, see:

"Chapter 27: Troubleshooting" on page 763

To find terms used in this guide, see:

"Glossary" on page 887

Related DocumentationThe following NetWorker product
documentation is available:

Installation Guides Release Notes

Fixed Bugs List

Disaster Recovery Guide

Command Reference Guide

Performance Tuning Guide

Error Message Guide

Compatibility Guides

All NetWorker product manuals and guides are provided in PDF
format on a separate Documentation Suite CD-ROM as part of the
product media kit. If you do not have access to this CD-ROM, you
can view and download any NetWorker documentation PDF file directly
from www.legato.com.
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Online Help and UNIX Man Pages

The NetWorker graphical user interfaces all contain online help.
Additionally:

UNIX users can access man pages for detailed help on commands.
Windows users can access help on commands from the NetWorker

Command Reference Guide

Conventions Used in This GuideThis document uses the following
typographic conventions and symbols to make information easier to
access and understand.

Convention Indicates Example

boldface Names of commands, daemons, options, programs, or
scripts

The nsradmin command starts the command-line version of the
NetWorker Administrative program.

italic in text Pathnames, filenames, computer names, new terms
defined in the Glossary or within the chapter, or emphasized
words

The specifications are created, one for each swap file, in
c:\pagefile.sys.

italic in command-line

A variable that must be provided in the command-line

save -s server_name

fixed-width Examples and information displayed on the screen

media waiting: recover waiting for 8mm 5GB tape volume name

fixed-width, boldface

Commands and options that must be entered exactly as shown

nsr_shutdown -a

Menu_Name>Command

A path or an order to follow for making selections in the user
interface

Volume>Change Mode>Appendable
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Where to Get HelpCompany, product, and technical information can
be obtained as follows.

Technical Support

For customers and partners with an active support agreement, go
to http://softwaresupport.emc.com for information about software
patches, technical documentation, and support programs.

For customers without an active support agreement, please
contact Support Sales and Renewals for more information.

Support Sales, Renewals, and Licensing

For additional information about EMC storage products and
services, go to:

http://www.legato.com/support/contact/index.htm

To license and register this product, go to:

http://www.legato.com/support/licensing

Important: Information that must be read and followed to ensure
successful backup and recovery of data

Backslash (\) Paths for both Windows and UNIX unless specified
otherwise

\logs

Convention Indicates Example

Important: Use the no_verify option with extreme caution.
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Your CommentsComments and suggestions about our documentation
are always welcome.

To provide feedback:

1. Go to http://softwaresupport.emc.com.

2. Navigate to the Product Documentation page.

To comment on a particular guide, click the Comments link next
to the guides title.

To tell us how you prefer to use documentation, click Document
Survey.


	
EMC Legato NetWorker, Release 7.3, Multiplatform
VersionAdministration Guide 19

Chapter 1: Overview

This chapter covers the following topics:

"The NetWorker Environment" on page 19 "NetWorker Features" on
page 21 "Common NetWorker Tasks" on page 23 "NetWorker User
Interfaces" on page 25 "NetWorker Services" on page 41

The NetWorker EnvironmentThe NetWorker environment provides the
ability to protect an enterprise against data loss. As the
enterprise grows, so does the complexity and importance of
protecting data. NetWorker software provides the power and
flexibility to meet these challenges.

The NetWorker software is a cross-platform client-server
application that provides the ability to remotely manage all
NetWorker clients and servers from a web-enabled, graphical
interface.
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1

NetWorker Components

Figure 1 on page 20 illustrates the main components in a
NetWorker environment.

Figure 1. NetWorker Components

Console Server

All NetWorker servers and clients are managed from the NetWorker
Console server. The Console server also provides reporting and
monitoring capabilities for all NetWorker servers and clients.

Web Browser

The Console server is accessed through a graphical interface
that can be run from any computer that has a web browser. Multiple
users can access the Console server concurrently from different
browser sessions. A computer that hosts the web browser can also be
a NetWorker client.

NetWorker Servers

Web Browser

DeviceConsole Server

Storage Node

NetWorker Clients

Datazones
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NetWorker Server

NetWorker servers provide services to back up and recover data
for the NetWorker client computers in a datazone.

Datazone

A datazone is a single NetWorker server and its client
computers. Datazones can be added as backup requirements
increase.

NetWorker Storage Node

A NetWorker storage node can be used to improve performance by
offloading from the NetWorker server much of the data movement
involved in a backup or recovery operation.

NetWorker Client

A NetWorker client computer is any computer whose data must be
backed up. The NetWorker Console server, NetWorker servers,
NetWorker storage nodes are also NetWorker clients.

NetWorker FeaturesThis section describes the major features that
distinguish the NetWorker software. Optional additions to the
NetWorker software are also listed.

Performance Features

Standard NetWorker performance features include:

Server parallelism, which enables several save streams to flow
to the server or storage node at the same time.

Multiplexing, which enables more than one save stream to write
to the same device at the same time.

Client parallelism, which enables the client to send more than
one save stream at a time.

Session management, which enables one to control the number of
save streams per device to maximize the performance of each
device.

Back up to file devices and optional subsequent staging to
near-line or offline volumes.
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Ease of Use

NetWorker software provides tools to make protection of critical
data easy to manage. With these tools, you can:

Use either the graphical interfaces or command-line programs to
manage NetWorker tasks and functions.

Administer and configure NetWorker functions from any network
computer with a web browser.

Grant permission to provide directed recovery operations.
Directed recovery is the capability for recovery of one clients
data to another client computer.

Obtain immediate answers to questions by accessing online help
and UNIX man pages. Windows users can also access the NetWorker
Command Reference Guide, which contains information that is
equivalent to the UNIX man pages.

Take advantage of the automatic media management feature to
allow the NetWorker server or storage node to label and mount
volumes as needed for backups.

Use the integrated knowledge base and technical bulletins at
http://softwaresupport.emc.com to find answers to common
questions.

Scalability

Existing NetWorker software can be scaled as storage management
needs grow. For example, you can:

Upgrade the basic level of server functionality, add support for
additional (or larger) autochangers, add support for more clients,
or add optional software modules without the need to reinstall the
server software.

Add special NetWorker Module client software to back up
databases and other non-file-system data.

Add support for remote storage nodes to control backup devices,
while the data management tasks remain centralized on a controlling
NetWorker server.

Add the EMC Legato License Manager (LLM) software to administer
all of your networks EMC software licenses from a single
server.
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Optional Software Additions

Optional additions to the NetWorker software include:

NetWorker Autochanger Module NetWorker Silo Software Module
NetWorker Archive Module NetWorker Database Modules (for backing up
several types of databases)

NetWorker Open File Connection Module (OFC) (Microsoft Windows
NT only) NetWorker SNMP (Simple Network Management Protocol) NDMP
(Network Data Management Protocol) support DiskXtender Data Manager
File System Support NetWorker OpenVault remote storage systems
(Windows only) Cluster support, including EMC FullTime AutoStart
License Manager Advanced reporting capability

Common NetWorker TasksThe following are some of the most common
tasks performed with the NetWorker Management Console:

How to Schedule a Backup

Follow these steps to schedule backups:

For more information about scheduling backups, see "Chapter 2:
Backing Up Data" on page 47.

1. Click the Enterprise button on the taskbar, and add NetWorker
servers.

2. Highlight a server. Right-click and select Launch
Application.

3. Click the Configuration button on the taskbar.

4. Define schedules, groups, and clients.
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How to Configure Media

Follow these steps to configure media using the NetWorker
Management Console:

For more information about configuring media, see "Chapter 3:
Configuring Libraries and Devices" on page 95.

How to Label Tapes

Follow these steps to label tapes from the NetWorker Management
Console:

For more information about labeling tapes, see "Chapter 12:
Media Management" on page 319.

1. Click the Enterprise button on the taskbar, and add NetWorker
servers.

2. Highlight a server. Right-click and select Launch
Application.

3. Click the Devices button on the taskbar.

4. In the tree view, right-click a server, and select Scan for
Devices.

1. Click the Enterprise button on the taskbar, and add NetWorker
servers.

2. Highlight a server. Right-click and select Launch
Application.

3. Click the Devices button on the taskbar.

4. In the tree view, expand Libraries, and highlight a library,
or select Devices.

5. In the Device list, right-click a device and select
Label.
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How to View Failed Backups

To see whether any backups have failed:

For information about viewing backup status information, see
"Chapter 15: Monitoring" on page 463.

NetWorker User InterfacesThe NetWorker application consists of
the following user interfaces:

"NetWorker Management Console Interface" on page 25 "NetWorker
Client Interface" on page 32 "NetWorker Character-Based Interface"
on page 41 "NetWorker Command-line Interface" on page 41

NetWorker Management Console Interface

The interface for NetWorker Management Console (also referred to
as NetWorker Console) consists of two main windows:

Console window Administration window

1. Click the Enterprise button on the taskbar, and add NetWorker
servers.

2. Highlight a server. Right-click and select Launch
Application.

3. Click Monitoring.
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Console Window

When NetWorker software is started, the Console window appears
as shown in Figure 2 on page 26.

Figure 2. Console Window

The Console window is the first point of access for NetWorker
tasks. Table 1 on page 26 lists the task-based windows that can be
launched from the Console window taskbar.

Table 1. Windows Launched from the Console Window (Part 1 of
2)

Button Window Description

Events View important messages about NetWorker and Console
servers. For more information about managed events, see "Events" on
page 463. The Administrator window can also be opened from this
location.

Enterprise Select a NetWorker server to manage and monitor the
server and its backup clients. Click this button to open the
Administration window for a NetWorker server.
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all

NetWorker servers. The Administrator window can also be opened
from this location.

Reports Configure and view Console reports. For more information
about reports, see "Chapter 14: Reporting" on page 407.

Setup Control administrative functions: User management Add,
edit, and delete Console user

accounts, restrict user views of servers. For more information
about user management, see "Managing Console Server Users" on page
483.

License management Manage NetWorker licenses. For more
information about license management, see "Managing Product
Licenses" on page 492.

Table 1. Windows Launched from the Console Window (Part 2 of
2)

Button Window Description
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Administration Window

NetWorker servers are managed through the Administration window
as shown in Figure 3 on page 28.

Figure 3. Administration Window

One can toggle between the Administration window and the Console
window.

Table 2 on page 28 lists the windows that can be launched from
the Administration window taskbar.

Table 2. Windows Launched from the Administration Window (Part 1
of 2)

Button Window Description

Monitoring Monitor various activities related to the NetWorker
server. For example, one could monitor the progress of a scheduled
backup and view any alerts from the Monitor window.

Configuration Manage the NetWorker server and its resources such
as clients, backup schedules, and policies. For example, one could
create a backup schedule, add NetWorker clients, and apply the
backup schedule to several NetWorker clients.
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How to Start Console for the First Time

These steps assume that the NetWorker software is installed and
that all of the software and hardware requirements have been met on
the computer that will access Console. For more information, refer
to the appropriate NetWorker Installation Guide.

To open Console for the first time:

1. Start a web browser session.

2. Enter the URL of the Console server:

http://server_name:http_service_port

where:server_name is the name of the computer where the Console
server component was installed.http_service_port is the IP port for
the embedded HTTP server. (The HTTP port is specified during
installation. The default HTTP port is 9000.)For
example:http://houston:9000

3. From the Welcome page, click Start NetWorker Management
Console.

4. From the Security Warning screen, click Start to run
NetWorker Management Console.

5. If JRE 1.4.2 was not already installed on the system, a
prompt to install it appears. Follow the on-screen instructions to
install JRE.

Once the JRE has been installed, the Java Web Start Desktop
Integration dialog box appears.

Devices Add, configure, and operate devices, libraries, and
silos for the NetWorker server.

Media Manage activities and resources related to backup volumes.
For example, one could mount a backup volume or create a template
for labeling backup volumes.

Table 2. Windows Launched from the Administration Window (Part 2
of 2)

Button Window Description
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6. Complete the Java Web Start Desktop Integration dialog box by
selecting one of the following options:

To place a shortcut on the desktop, click yes. To decline having
a shortcut placed on the desktop, click No. To have the option to
decide later, click Ask Later.

7. In the NetWorker Management Console Login dialog box, enter
the username and password.

Important: The default password for the administrator is
administrator. For added security, change the password during the
first login session. If the administrator password is lost,
forgotten, or otherwise needs changing, see "Managing Console
Server Users" on page 483.

8. Click OK.

The Console Window appears.

How to Start Console after the First Time

After Console has been started the first time, start it by using
any of the following methods:

Point the browser to the same URL as in "How to Start Console
for the First Time" on page 29.

Double-click the NetWorker Console product name in the Java Web
Start Application Manager.

Double-click the desktop icon, if one was set up through the
Java Web Start Application Manager.

How to Open the Administration Window

To select a NetWorker server and open the Administration
window:

1. From the Console window, click Enterprise.

2. From the left pane, click a NetWorker server in the
Enterprise list.

3. From the right pane, click the application.

4. From the Enterprise menu, select Launch Application.

The Administration window is launched as a separate
application.
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How to Sort Tables

Console softwares organization and display of tabular
information can be changed. Tables can be sorted by column heading,
and then by alphabetic or numeric order within those columns.

To rearrange information in a table:

1. Drag-and-drop the column heading to its new position.

2. Click the column heading to sort the items into alphabetic
and numeric order.

An arrow appears in the column heading to indicate the sort
order.

Example: Sorting Managed Events

John wants to see all the managed events about servers that were
unreachable by the Console server.

1. From the Console window, John clicks the Events button.

2. He clicks and drags the Message column until it is over the
Priority column, where he drops it.

3. He clicks the Message column heading so that a down arrow
appears.

Now he can scan down the list of messages until he finds three
servers, all with the message, Unable to connect to server.

John could also generate a Managed Event Details report to get
the same information, which could be printed or exported for use in
another application. For further information about reports, see
"Chapter 14: Reporting" on page 407.

How to Perform MultiColumn Sorts of a Table

To sort on two or more columns within a table:

1. Click the column to be used as the last sort key.

2. Click the column to be used as a next last sort key and so on
until the primary column is selected.
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For example, given a large table of Events, one could select the
Time column as the tertiary sort key, the Category column for the
secondary sort key, and the Server name as the primary sort key.
The resulting display would list the Servers in alphabetical order,
and the events for each server would be grouped by category and
would display in chronological order.

How to Display or Hide Columns in a Table

To select which columns to display in a table:

1. From the View menu, select Choose Table Columns.

2. Click a column name to select or unselect the column.

3. Click OK.

How to Set User Interaction Preferences

One can set various user preferences such as the user interface
font, font size, window sizes, and table settings.

To set user preferences:

1. From the View menu, select User Preferences.

2. Set various user preference options as appropriate.

3. Click OK.

NetWorker Client Interface

This section describes the interface from which users can
recover data and perform ad hoc backup and archive operations. Ad
hoc operations are not scheduled. Instead, they are performed when
a user wants to back up or archive one or more files on the
NetWorker client immediately. Scheduled backup and archive
operations are set up through the Console interface. For
information about the Console interface, see "NetWorker Management
Console Interface" on page 25.
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Windows Client Interface

The NetWorker User program shown in Figure 4 on page 33 is the
Windows client interface.

Figure 4. NetWorker User Program

How to Start the User Program

To start the NetWorker User program, perform one of the
following tasks:

Click the Windows Start button and select Programs>NetWorker
Group>NetWorker User.

From the Administration window, click Monitoring and then from
the Monitoring menu, select Launch NetWorker User Application.

Note: The NetWorker client package must be installed on the host
from which you are attempting to start the NetWorker User
program.

To start the NetWorker User program, you must belong to the
appropriate Windows groups. Table 3 on page 34 lists the groups
that you must belong to in order to run the NetWorker User
program.
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The Backup Operators and Administrators groups are local and
remote Microsoft security groups.

Toolbar Buttons

The NetWorker User program has a toolbar with buttons for common
User program tasks. Table 4 on page 34 describes the function of
each button.

Table 3. NetWorker User Groups Requirements

Logged on Workstation ServerServer (domain controller only)

Locally Backup Operators orAdministrators

Backup Operators orAdministrators

Not applicable

To the domain Domain Administrators

Domain Administrators Backup Operators orAdministrators

Table 4. NetWorker User Toolbar Functions

Button Name Function

Backup Starts an ad hoc (unscheduled) backup of the client's
data to a NetWorker server.

Recover Starts a recovery operation to retrieve copies of saved
data back to the client computer.

Archive Starts an archive operation to save copies of data to a
server for storage on an archive volume. Once the data is stored on
the archive volume, you have the option of removing the data from
the disk.

Verify Starts a verification operation to ensure that the data
items just backed up are the same as those currently on the
disk.
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Browse Window

The NetWorker User program browse window appears when one of the
following is selected:

A toolbar button. A Backup, Recover, Archive, Verify, or Local
Directive command from the

NetWorker User File menu.

The browse window, shown in Figure 5 on page 35, displays the
directory tree of the file system that is being browsed.

Figure 5. Example of Browse Window

Note: When you mark a disk volume or directory for an operation,
all of its nested subdirectories and files are also marked.

A check mark beside an item name indicates that the item is
marked for backup, recovery, archiving, or verification.

The Attributes column indicates any special handling option that
has been applied:

P The item is marked for password-protection. For more
information, see "Password Protecting Windows or NetWare Backup
Data" on page 67.

E The item is marked for password-protection and encryption. For
more information, see "Encrypting Backup Data" on page 68.

C The item is marked for compression. For more information, see
"Compressing Backup Data" on page 71.
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How to Connect to a NetWorker Server

A typical user that runs the NetWorker User program only needs
to connect to the NetWorker server that performs scheduled backups.
However, to perform a directed recovery or to back up files to
another server, it may be necessary to connect to a different
NetWorker server.

Note: Before the NetWorker User program can connect to a
NetWorker server, the client computer must be set up as a Client
resource on that server. For information about creating a Client
resource, see "Task 7: Create a Backup Client Resource" on page
55.

To connect to a NetWorker server:

1. From the Operation menu, select Change NetWorker Server.

2. In the Change Server dialog box, select a server from the
list of available NetWorker servers. If the server is not listed,
do one of the following:

Click Update List to search the network for available NetWorker
servers.

Type the servers hostname.

3. Click OK.

UNIX Client Interface

The UNIX version of the NetWorker client interface uses separate
graphical interface programs for performing each of the following
tasks:

Ad hoc backups (nwbackup) Recoveries (nwrecover) Archiving
(nwarchive) Retrieval of archived data (nwretrieve)

Note: The NetWorker client package must be installed on the host
from which you are attempting to start any of the client graphical
interface programs.

The Ad Hoc Backup Program

Use the nwbackup program to perform an ad hoc backup initiated
from the client computer, rather than from the NetWorker servers
scheduled group backup.
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To start the nwbackup program, perform one of the following
tasks:

From the Administration window, click Monitoring and then from
the Monitoring menu, select Launch NetWorker User Application.

Enter the following command:nwbackup

To specify the NetWorker server to connect to, enter the -s
server option with nwbackup:nwbackup -s server

Figure 6 on page 37 displays the nwbackup program.

Figure 6. nwbackup Program
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The Recover Program

Use the nwrecover program to recover backed-up files.

To start the nwrecover program, enter the following command:

nwrecover

To specify the NetWorker server to connect to, enter the -s
server option. To specify the NetWorker client, use the -c client
option:

nwrecover -s server -c client

If the -c option is not entered, the local computer is used by
default.

Figure 7 on page 38 displays the nwrecover program.

Figure 7. nwrecover Program
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The Archive Program

Use the nwarchive program to manually archive files to a
NetWorker server.

Note: Archive functionality is enabled by license. For more
information on licensing, see "Chapter 8: Archiving" on page
219.

To start the nwarchive program, enter the following command:

nwarchive

To specify the NetWorker server to connect to, enter the -s
server option with nwarchive:

nwarchive -s server

Figure 8 on page 39 displays the nwarchive program.

Figure 8. nwarchive Program
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The Archive Retrieval Program

Use the nwretrieve program to retrieve archived files.

To start the nwretrieve program, enter the following
command:

nwretrieve

To specify the NetWorker server to connect to, enter the -s
server option with nwretrieve:

nwretrieve -s server

Figure 9 on page 40 displays the nwretrieve program.

Figure 9. nwretrieve Program
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NetWorker Character-Based Interface

The NetWorker character-based interface (nsradmin) can be used
to perform configuration and management tasks for a NetWorker
server.

To start the nsradmin interface, enter the following
command:

nsradmin

For more information about nsradmin, refer to the NetWorker
Command Reference Guide or the UNIX man pages.

NetWorker Command-line Interface

NetWorker client and server tasks can also be performed by
entering commands at the prompt. For information about these
commands, refer to the NetWorker Command Reference Guide or the
UNIX man pages.

NetWorker ServicesTable 5 on page 41 describes the main services
that provide NetWorker software functionality. For more information
about these services, refer to the NetWorker Command Reference
Guide or the UNIX man pages. For information about service port
requirements when configuring a firewall, see "Appendix B: Firewall
Support" on page 823.

Table 5. Main NetWorker Services (Part 1 of 2)

Service Function

ansrd Monitors an active recover session. This agent process is
spawned by nsrd in response to a recover session.

gstd Controls other services provided by the Console server.
This master service is called the Generic Services Toolkit (GST)
service.

hagentd Manages the NetWorker host agent client modules and
maintains the NetWorker host-agent resource database.

nsrlcpd Provides a uniform library interface to the media
management service nsrmmgd.

nsrd Provides save and recover operations. This master service
controls other services on the NetWorker server, clients, and
storage nodes.
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remote

execution requests and executes the save programs on the
client.

nsrindexd Inserts entries in the client file index based on
information passed by the save program.

nsrjobd Allows for monitoring and long term recording of
NetWorker activities. All functionality requiring monitoring or
remote execution is handled with help of the nsrjobd service.

nsrmmd Provides device support, generates mount requests, and
multiplexes save set data during a multiclient backup. The nsrd
service can start one nsrmmd service for each enabled device. An
additional nsrmmd service is started while mount requests are
pending.

nsrmmdbd Provides media and save set database management
services to the local nsrd and nsrmmd service, and records entries
in the media database.

nsrmmgd Provides an RPC-based service that manages all jukebox
operations on behalf of the nsrd service.

nsrpm (Windows only)

Works with the energy-saving features of Windows to keep
NetWorker components running properly during power-saving modes. It
can be disabled if not needed.

Table 5. Main NetWorker Services (Part 2 of 2)

Service Function
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Manually Stopping and Starting NetWorker Services

NetWorker hosts might need to be manually stopped and restarted
in conjunction with configuration and troubleshooting
activities.

Table 6 on page 43 lists the main NetWorker services that are
required for each type of NetWorker host.

Note: The NetWorker service nsrmmd is only present if one or
more devices are enabled.

Stopping and Starting the Console Server

This section describes how to stop and start the Console server
service.

How to Stop the Console Server on Windows

To stop the Console server:

1. Log in as a Windows Administrator and right-click My Computer
and select Manage.

2. Expand Services and Applications and select Services.

3. Right-click EMC LEGATO GST Service (gstd), then select
Stop.

Table 6. Main Services for NetWorker Hosts

NetWorker Host NetWorker Service

Console server gstd nsrexecd

NetWorker server nsrd, nsrexecd, nsrindexd, nsrjobd, nsrlcpd,
nsrmmd, nsrmmdbd, nsrmmgd

NetWorker client nsrexecd

NetWorker storage node nsrexecd, nsrlcpd, nsrmmd

License Manager lgtolmd
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How to Start the Console Server on Windows

To start the Console server:

1. Log in as a Windows Administrator and right-click My Computer
and select Manage.

2. Expand Services and Applications and select Services.

3. Verify that the NetWorker client is running.

The NetWorker Remote Exec Service (nsrexecd) should have a
status of Started. If the service is not started:a. Right-click
NetWorker Remote Exec Service.b. Select Start.

4. Right-click EMC LEGATO GST Service (gstd), then select
Start.

How to Stop the Console Server on UNIX

To stop the Console server:

1. Log in as root.

2. Enter the following command:

/etc/init.d/gst stop

How to Start the Console Server on UNIX

To start the Console server:

1. Log in as root.

2. Verify that the NetWorker client is running.

For example, enter the following command:/usr/bin/ps -ef | grep
nsr

If the NetWorker client is running, a message similar to the
following appears:root240 1 0 ? 0:04 /usr/sbin/nsrexecd -s
mysrvr

If the NetWorker client is not running, start it. For
information about starting the NetWorker client, see "Start a
NetWorker Host on UNIX" on page 46.

3. Start the Console server by entering the following
command:

/etc/init.d/gst start
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Stopping and Starting a NetWorker Server, Client, or Storage
Node

This section describes how to manually stop and start the
services for a NetWorker server, client, or storage node.

How to Stop a NetWorker Host on Windows

To stop a NetWorker server, client, or storage node:

1. Log in as a Windows Administrator.

2. Right-click My Computer and select Manage.

3. Expand Services and Applications and select Services.

4. Select NetWorker Remote Exec Service (nsrexecd), right-click,
and select Stop.

How to Start a NetWorker Host on Windows

To start a NetWorker server, client, or storage node:

1. Log in as a Windows Administrator.

2. Right-click My Computer and select Manage.

3. Expand Services and Applications and select Services.

4. Start the appropriate service.

NetWorker server:Right-click the NetWorker Backup and Recover
Server service (nsrd) and select Start.

NetWorker client or storage node:Right-click the NetWorker
Remote Exec Service (nsrexecd) and select Start.

How to Stop a NetWorker Host on UNIX

To stop the NetWorker services:

Log in as root and enter the following:nsr_shutdown
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How to Start a NetWorker Host on UNIX

To start NetWorker services:

Log in as root and enter the appropriate startup command listed
in Table 7 on page 46.

How to Shut Down a NetWorker Host on Mac OS X

To shut down the NetWorker host:

1. Log in as a Mac Administrator and Open the Mac OS X Terminal
application utility.

2. Shut down the NetWorker service by entering the following
command:

# SystemStarter stop NetWorker

How to Start a NetWorker Host on Mac OS X

To start the NetWorker host:

1. Log in as a Mac Administrator and open the Mac OS X Terminal
application utility.

2. Start the NetWorker client by entering the following
command:

# SystemStarter start NetWorker

Table 7. NetWorker Startup Commands

Operating System Startup Command

Solaris, Linux, IRIX /etc/init.d/networker start

HP-UX /sbin/init.d/networker start

HP Tru64 UNIX /sbin/init.d/NSRstartstop start

AIX /etc/rc.nsr
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Chapter 2: Backing Up Data

This chapter covers the following topics:

"Scheduled Backups" on page 47 "Save Sets" on page 57 "Ad Hoc
Backups" on page 60 "Verifying Backed-Up Data" on page 66 "Password
Protecting Windows or NetWare Backup Data" on page 67 "Encrypting
Backup Data" on page 68 "Compressing Backup Data" on page 71
"Special Data Handling for NetWorker Clients on Windows" on page 72
"Backing Up NetWorker Console Management Data" on page 72 "Backing
Up Windows Mount Points" on page 74 "Backing Up the Windows Content
Index Server" on page 77 "Backing Up Windows DHCP and WINS
Databases" on page 78 "Windows Backup and Recovery Notes" on page
79 "Customizing the Backup Command" on page 82 "Considerations for
Backing Up Raw Partitions" on page 92

Scheduled BackupsThis section explains how to plan and create
scheduled backups.

Planning a Scheduled Backup

This section uses a scenario with the requirements of an
accounting department to highlight tasks to consider when planning
a scheduled backup.
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Example: Planning Scheduled Backups for the Accounting
Computers

Company XYZ wants to ensure that all of the computers in the
Accounting department are backed up according to the requirements
listed in Table 8 on page 48. This table also maps each requirement
to specific NetWorker features.

Table 8. Accounting Department Backup Requirements (Part 1 of
2)

Requirement NetWorker Feature For More Information

Backups occur at the same time.

Backup Schedule Backup Group

"Task 1: Set Up a Schedule for Backups" on page 50

"Task 2: Set Up a Group for Backup Clients" on page 50

Accounting backups for the past 3 months are available
immediately.

Browse Policy "Task 3: Set Up Policies for Quick Access and Long
Term Storage" on page 51

Accounting backups for the past 7 years are available, though
not necessarily immediately.

Retention Policy "Task 3: Set Up Policies for Quick Access and
Long Term Storage" on page 51

Backups are routed to volumes that can be identified as
Accounting backup volumes.

Label Template Pools

"Task 4: Set Up a Label Template to Identify Volumes" on page
52

"Task 5: Set Up a Pool to Sort Backup Data" on page 53

To avoid unnecessary backups, do not back up files with a .tmp
extension.

Directives "Task 6: Set Up Directives for Special Processing" on
page 54
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Setting Up a Scheduled Backup

You can create a scheduled backup quickly by using the Client
Configuration Wizard. For more information, see "Using the
NetWorker Client Configuration Wizard" on page 56.

To exercise more control over scheduled backups than is possible
by using the Client Configuration wizard, complete the following
tasks:

"Task 1: Set Up a Schedule for Backups" on page 50 "Task 2: Set
Up a Group for Backup Clients" on page 50 "Task 3: Set Up Policies
for Quick Access and Long Term Storage" on

page 51 "Task 4: Set Up a Label Template to Identify Volumes" on
page 52 "Task 5: Set Up a Pool to Sort Backup Data" on page 53
"Task 6: Set Up Directives for Special Processing" on page 54 "Task
7: Create a Backup Client Resource" on page 55

Note: If during the completion of any task in this section, the
following error message appears:

user user_name needs to be on administrators list

it means that you do not have NetWorker permissions to make
configuration selections. For information about getting
permissions, see "Managing Server Access" on page 522.

Note: For specific information about backing up NetWorker
clients on Mac OS X, see "Appendix F: Mac OS X Support" on page
881.

The same files and folders are backed up on each accounting
computer.

Client resource "Task 7: Create a Backup Client Resource" on
page 55

Non-accounting data need only be recoverable for one year.

Browse Policy Retention Policy Client resource

"Task 3: Set Up Policies for Quick Access and Long Term Storage"
on page 51

"Task 7: Create a Backup Client Resource" on page 55

Table 8. Accounting Department Backup Requirements (Part 2 of
2)

Requirement NetWorker Feature For More Information
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Task 1: Set Up a Schedule for Backups

A schedule can be applied to each client backup. For more
information about schedules, see "Chapter 4: Backup Groups and
Schedules" on page 127.

To create a schedule for backups:

1. From the Administration window, click Configuration.

2. In the expanded left pane, select Schedules.

3. From the File menu, select New.

4. In the Name attribute, enter a name for the schedule.

5. From the Period attribute, select Week or Month.

Select Week to create a weekly backup schedule. For example, if
a full backup for a Friday is selected, every Friday will have a
full backup.

Select Month to create a monthly schedule. For example, if a
full backup for the first of the month is selected, every month
will have a full backup on the first of the month.

6. Select a backup level for each day in the weekly or monthly
period.

a. Select a day.b. Right-click and from the Set Level menu,
select a backup level.

7. If required, select an override backup level for any day. An
override occurs once only for the selected day.

a. Select a day.b. Right-click and from the Override Level menu,
select a backup level.

8. Click OK.

Task 2: Set Up a Group for Backup Clients

A backup group specifies the time of day when a backup occurs.
Creating groups for backup clients enables you to:

Balance backup loads to reduce the impact on your network and
the NetWorker server.

Sort data to specific backup volumes. To sort data, groups are
used in conjunction with backup pools.

For more information about groups, see "Chapter 4: Backup Groups
and Schedules" on page 127.
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To create a group:

1. From the Administration window, click Configuration.

2. In the expanded left pane, select Groups.

3. From the File menu, select New.

4. In the Name attribute, enter a name for the group.

5. In the Comment attribute, enter a description of the
group.

6. For the Start Time attribute, enter a new time, unless it is
appropriate to maintain the default time of 3:33 a.m.

Ensure that start times for different groups are far enough
apart so that one group has completed backing up before the next
group starts.

7. For the Autostart attribute, select Enabled.

8. In the Printer attribute, enter the name of the printer on
which bootstrap save set information will be printed.

9. Click the Advanced tab.

10. For the Client Retries attribute, change the number of
retries, if necessary.

This value specifies the number of times the NetWorker software
attempts to back up a failed client.

11. Click OK.

Task 3: Set Up Policies for Quick Access and Long Term
Storage

Backup clients specify two policies: a browse policy and a
retention policy.

A browse policy determines how long backup data will be
available for quick recovery.

A retention policy determines how long backup data will be
available for recovery, though not necessarily quickly. For
example: If it is likely that accounting data would need to be
recovered within

the past year, a browse policy of one year would be appropriate.
If the same accounting data had to be recoverable for up to
seven

years even though the likelihood of needing to recover it was
low, a retention policy of seven years would be appropriate.

For more information about browse and retention policies, see
"Chapter 5: Browse and Retention Policies" on page 163.
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To create a policy:

1. From the Administration window, click Configuration.

2. In the expanded left pane, select Policies.

3. From the File menu, select New.

4. In the Name attribute, enter a name for the policy. Choose a
name that reflects the length of time for which the policy
specifies. For example, if the policy is for 15 months, enter 15
months.

5. In the Comment attribute, enter a comment about the
policy.

6. In the Number of Periods attribute, enter the number of
periods applied to the policy. For example, if you choose months
for the Period attribute and three for the Number of Periods
attribute, then the policy lasts for three months (one
quarter).

7. From the Period list, select a period. This attribute works
in conjunction with the Number of Periods attribute. For example, a
quarterly policy is configured in terms of the number of months
(three). A week as seven days beginning on Sunday, a month is the
calendar month, and a year is the calendar year.

8. Click OK.

Task 4: Set Up a Label Template to Identify Volumes

Every backup volume requires a unique label for identification.
The NetWorker server creates a unique label for each volume by
applying a label template. For more information about label
templates, see "Chapter 7: Sorting Backup Data" on page 197.

To create a label template:

1. From the Administration window, click Media.

2. In the expanded left pane, select Label Templates.

3. From the File menu, select New.

4. In the Name attribute, enter a name for the label
template.

5. In the Comment attribute, enter a description for the label
template.
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6. In the Fields attribute, enter the labels components. Place
each label component on a separate line. The template can use any
or all of these components, although at least one range component
must be added:

Range of numbers for example, 001-999 Range of lowercase letters
for example, aa-zz Range of uppercase letters for example, AA-ZZ
Character string for example, Accounting

Ranges of numbers or letters change incrementally with each new
label. For example:

First label:Accounting.001Second label:Accounting.002Third
label:Accounting.003

7. Select a Separator and click OK.

If no symbol is selected, the components will have no separators
(for example, Accounting001).

8. Click OK.

Task 5: Set Up a Pool to Sort Backup Data

A backup pool is a collection of volumes to which backup data is
written. Use pools to sort backup volumes so that the volumes are
easy to locate when they are needed. For more information about
pools, see "Chapter 7: Sorting Backup Data" on page 197.

To create a back
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